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LNG Tank Design 
Checks 
The LNG Tank System carries out design checks to supported design codes for 
specified load combinations.  

Its use requires the Microsoft Excel spreadsheet application to be installed in advance 
for full functionality as certain applications may use it during the design or reporting 
process. For example, the Wizard imports the spreadsheet template for design load 
combinations. 

Due to the low temperature of LNG, a thermal analysis requiring solid elements has to 
be performed and this often causes difficulties for load combinations that are based on 
structural results when the structural analysis is performed using shell elements. The 
LNG Tank System imports the temperatures and temperature gradients that are 
obtained from thermal analysis using solid elements into shell elements and allows all 
required load combinations to be assembled in a single model, to enable design check 
results to be obtained in an efficient way. 

This manual focuses on the procedures involved in performing design checks using the 
LNG Tank System. A separate manual titled ‘LNG Tank System (Metallic Tank): Part 
1 – Tank Wizard’ provides details of modelling concepts used to build the range of 
models supported.  

User inputs shown in the manual ‘LNG Tank System (Metallic Tank): Part 1 – Tank 
Wizard’ are used in this manual unless otherwise stated. 
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Base Model 
Preparations 

User Inputs 
Select the menu item LNG Tank >Tank Definition… 

 

Fig 1 User Input for Tank Dimension and Load 

‘3D Shell Structural’ should be checked from ‘Target models to build’. Complete all 
the inputs and click OK to save the data with the name ‘Tnk1’. 
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Build Base Model 
The Base Model for a design check can be built by selecting the menu item LNG 
Tank> Create 3D Shell Model… 

 

Fig 2 LNG Tank for Base Model for Design Check 

 Depending on the selected ‘Tank Type’ in Tank Definition, relevant user inputs 
are enabled and not required user inputs are disabled.   

 

The model built is shown below. 
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Fig 3 Base Model for Design Check 

Analyses 
A number of analyses having a total of 49 loadcases are set-up in the model. 

 Base Analysis A static analysis. A total of 28 loadcases are provided including 
4 thermal loading. Thermal loading can be added to the Base Analysis using 
‘LNG Tank > Add Loading> Thermal…’ The result of a separate thermal 
analysis is to be imported here. 

 Seismic Analysis Equivalent peak seismic acceleration and hydrodynamic 
loading are to be added.  

 Staged Construction Analysis 19 construction stages are defined with self-
weight only. 

 CRSH Analysis As for Staged Construction Analysis, combinations have been 
added to consider the pure effect from Creep and Shrinkage alone. This is 
obtained by subtracting the results in Analysis 5 (including CRSH) and the 
results in Analysis 4 (not considering CRSH). 

 Eigenvalue Analysis To obtain Eigenvalue results. 
 



Base Model 

6 

 

Fig 4 Analyses Available in Base Model 

Loadings 
Self weight is assigned in all analyses. 

• In the Base Analysis, 20 loadcases are provided, including 4 thermal loading.  

• In the other analyses (with the exception of the self weight) loading is not yet 
assigned. 

Base Load Combinations 
As seen in [Fig 4], 5 load combinations are pre-defined.  

Template for load combinations 
A template for use in defining design load combinations is saved in the LUSAS 
installation folder LUSAS200\Programs (x86)\scripts\Tank with the name of 
Tank_Template_Combinations.xlsx 

Alternatively, a template can be downloaded by clicking the ‘Template Download’ 
button in the ‘Design Load Combinations’ dialog (LNG Tank > Design Checks > 
Design Load Combinations). The template for design load combinations will be saved 
in the current working folder with the name of Tank_Template_Combinations.xlsx.  
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Fig 5 Design Load Combinations
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Thermal Analysis 
Thermal analysis that requires the evaluation of heat transfer through thickness cannot 
be performed with shell elements, so a thermal analysis using 2D axisymmetric solid 
elements is required instead. 

Thermal Analysis for Max Environmental Temperature 
Select the LNG Tank > Create 2D Model > Coupled Thermal/ Structural… menu 
item, and assuming the default inputs are for maximum temperature, perform a 2D 
Thermal Analysis with the input data of ‘Tnk1 – Max Temperature’.  

• Enter Example - Max for the model file name and click OK. 
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Fig 6 Dialog for Thermal Analysis (Max) 

The current shell model will be closed and a new 2D axisymmetric solid model suitable 
for thermal analysis will be built. 
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Fig 7 Thermal Analysis for Max Environmental Temperature 

• Solve the model, and in the Analyses  treeview, set the loadcase Operating 
Condition (Thermal) active.  

• The Equivalent Uniform Temperature and Linear Temperature Gradient through 
thickness can be computed and saved in a spreadsheet by selecting the menu 
item LNG Tank >Excel Tools> Export Temperatures… 

 

Fig 8 Extraction Thermal Max Results 

In the current working folder, the file ThermalResult-Max.xlsx containing the 
extracted results for Roof/Slab/Wall is created. 
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Fig 9 Extracted Thermal Results in a Spreadsheet 

Thermal Analysis for Min Environmental Temperature 
To perform additional thermal analyses for a minimum environment temperature, re-
select the menu item LNG Tank >Tank Definition… 
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Fig 10 User Input for Min Environmental Temperature 

• Enter 10 (Celsius) for both the Initial Temperature (Structure), Initial 
Temperature (Soil) and the External Temperature. The Initial Temperature 
(Structure) is the temperature at the time when concrete is poured, hence zero 
stress will be occurred at this temperature.  

• Save these inputs with name ‘Tnk2-Min Temperature’. 

• Select the menu item LNG Tank > Create 2D Model> Coupled 
Thermal/Structural… and enter Example - Min for the model file name, then 
click OK. 
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Fig 11 Dialog for Thermal Analysis (Min) 

• Solve the model, and in the Analyses  treeview, set the loadcase Operating 
Condition (Thermal) active.  

• Export results into a spreadsheet by selecting the menu item LNG Tank > 
Excel Tools> Export Temperatures… 
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 Fig 12 Extraction Thermal Min Results 

Update Base Model 
The thermal analysis results can be converted to 3D loading for load combinations. 

• Close the thermal model and open the shell model of ‘Test.mdl’. 

• Select the menu item LNG Tank > Add loading> Thermal… then select the 
spreadsheets for thermal analysis results and click OK. 

 
Fig 13 Dialog for Adding Thermal Loading 

The thermal analyses results are converted into equivalent structural temperature 
loadings in the 3D shell model. 
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Fig 14 Temperature Loading from Thermal Analyse
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Seismic Analysis 
Preparation 

A seismic analysis considering fluid-soil-structure interaction under seismic action 
should be carried out prior to the 3D shell model investigation. The inertial and 
hydrodynamic peak effects obtained from a seismic analysis can be transformed to 
equivalent static loading for a 3D model in the form of accelerations that will act on the 
structural masses and other structural loadings. 

Update Base Model 
Both OBE and SSE loadings can be defined by selecting the menu item LNG Tank > 
Add loading> Seismic…  
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Fig 15 Dialog for Adding Seismic Loadings 

Horizontal Loadings 
Based on the given inputs, the loadings are defined as shown below. The acceleration 
loadings are directly used for defining Body Force loading in Modeller, and the other 
loadings are converted to equivalent structural loadings.  
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Fig 16 Horizontal Seismic Loading for Roof (SSE) 

 

Fig 17 Horizontal Seismic Loading for Wall (SSE) 
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Fig 18 Horizontal Seismic Loading for Base Slab (SSE) 

 

Fig 19 Horizontal Seismic Loading of Liquid Force (SSE) 

 The force of the liquid is transferred to the Base Slab through the inner tank, so 
the loading is applied at the location of the inner tank wall. 

 The total force defined from user input is 500E3 kN in the global X direction, 
however the pressure of the liquid acts perpendicular to the inner tank wall 
surface with an intensity following a cosine variation. 

 A cylindrical local coordinate system is applied to the lines to ensure loading is 
in a radial direction. 
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Fig 20 Horizontal Seismic Loading of Overturning Moment from Base Slab (SSE) 

 

 

Fig 21 Horizontal Seismic Loading of Overturning Moment from Inner Tank (SSE) 

 

Vertical Loadings 
The acceleration loading is directly used to define Body Force loading in Modeller 
except for the acceleration for the Inner Tank. As the Inner Tank is not included in the 
meshed model, the loading is converted to equivalent structural loading.  
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Fig 22 Vertical Seismic Loading for Roof (SSE) 

 

Fig 23 Vertical Seismic Loading for Wall (SSE) 
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Fig 24 Vertical Seismic Loading for Base Slab (SSE) 

 

Fig 25 Vertical Seismic Loading for Inner Tank (SSE) 

 The inner tank is not included as structural elements, so the vertical loading 
from the inner tank should be converted for structural loading. 
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Fig 26 Vertical Seismic Loading for Liquid (Hydrostatic, SSE) 

 The given liquid pressure is 400E3 kN is converted as a distributed load for 3D 
model. 
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Staged 
Construction 
Analysis 

Update Base Model 
By selecting the menu item LNG Tank > Add Loading > Staged Construction 
Loads… the loadings for Staged Construction Analysis will be created and assigned to 
the appropriate loadcases. Dead loads will reference the data defined at the previous 
step of ‘Base Model’, hence no further input for loading is required. 

 

Fig 27 Dialog for Adding Staged Construction Analysis 
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Stage Definition and Loadings 
The following stages and loadings are ready. 

Stage Description Note 

No. 1 Annular part  

No. 2 1) + Circular part  

No. 3~16 2) + Wall is added up in stages  

No. 17 16) + Inner Tank Work  

No. 18 17) + Roof Complete  

No. 19 18) + Final   

Table 1 Sequence of Construction Stages  

 

 

Fig 28 Stage 1 ~ 2 of Staged Construction Analysis 

Stage 1 builds the annular part of the slab.  

Stage 2 adds the central part of slab.  

Note that self weight is always assigned when a new part of the structure is added. 
Loading defined and assigned at a stage is inherited by the subsequent stages. 
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Fig 29 Stage 3 ~ 16 of Staged Construction Analysis 

At Stage 16, the Wall construction is complete. 
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Fig 30 Stage 17 ~ 19 of Staged Construction Analysis 

In a double steel tank, it is assumed that the roof is built in one go and no prestress is 
considered.  

Stages 16 assumes that the Inner tank work is completed. At this stage, dead load for 
insulations acting on slab and wall will be assigned.  

Stages 17 assumes that the roof is completely built. At this stage, the rest of dead load 
for insulation acting on Roof will be assigned.  

Stage 19 is the final stage. The structures are complete as built, and all loadings for the 
operating condition are added. 

User Updates 

Construction Sequence 
If required, additional loadings or stages can be added.  
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To duplicate loading types within the Analyses  treeview, the Copy and Paste 
options can be used as shown below. This will create additional stages (loadcases) and 
include all loadings previously assigned to the copied loadcase. 

 

   
 

 
Fig 31 Copy and Paste of Stages (Loadcases) 

The required activation/deactivation/loadings/support can now be assigned or removed 
for this stage. The loadings at other loadcases can be also copied and pasted in the same 
way if required. 
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CRSH Analysis 
Preparation 

CRSH Analysis considers the effect of creep and shrinkage changing with time and 
requires a nonlinear creep and shrinkage material model to be used. This is defined by 
selecting the Attributes > Material > Concrete (Nonlinear) menu item. 

• Select ‘EN 1992 (2004-2014)’, accept the default inputs, and save with name of 
‘CRSH EN1992’. 

  

Fig 32 Creep & Shrinkage Material for Base Slab 

Update Base Model 
By selecting the LNG Tank > Add CRSH Loading… menu item, the loadings for the 
Creep and Shrinkage Analysis will be created and assigned to the appropriate 
loadcases. Dead loads will reference the data defined at the previous step of ‘Base 
Model’, hence no further input for loading is required. 
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Fig 33 Dialog for Adding CRSH Analysis 

 Age at Activation: The concrete age at the time of activation (i.e. cast removal) 
 Age when shrinkage begins: The number of days/hours etc. between the 

concrete being cast and shrinkage being considered to have started. For Codes 
of Practice where autogenous shrinkage and drying shrinkage are handled 
separately, such as EN1992-1-1, this input refers to the age at which drying 
shrinkage begins; autogenous shrinkage is always taken as occurring from when 
the component is cast. For Codes of Practice where there is no such distinction, 
this value is used to define the commencement age for all shrinkage. 

 

Make sure the Creep and Shrinkage Material dataset for base slab is selected. 

Stage Definition and Loadings 
The stages defined in this analysis are the same as for Staged Construction Analysis. 

Additionally, the ‘Age’ property is assigned to Base Slab, and the time gap between 
each stage and the Total Response Time are defined for each stage. 

User Updates 

Loadings 
As discussed in the section titled Staged Construction Analysis, some loadings may 
need to be updated. 

Construction Schedule 
The duration (length of time) of each stage is set to 10 days by default for all stages. 
This should be updated to follow the actual construction schedule.  
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Each stage uses a Nonlinear Control, and both the time and Total Response Time 
should be updated together.  

For example, if the time gap between Stage 4 and Stage 5 needs to be changed to 15 
days, Nonlinear Control for Stage 4 should be updated. 

Default settings for Stage 5 are shown below.   

 

Fig 34 Nonlinear Control for Stage of Wall 2 (Default) 

 Initial Time Step  : Analysis is performed at every 10 days. 
 Total Response Time  : This stage lasts up to 50 days from the start of 1st 

Stage. 
 

The number of days that the current stage lasts for is the Total Response Time of 
current stage minus Total Response Time of the previous stage. 

By modifying Total Response Time to 55, this stage lasts for 5 more days. (e.g. a total 
of 15 days)  

Note that the Total Response Time for the subsequent stages should be also updated.  
Otherwise the 6th Stage will last only 5 days. 

Modifying Initial Time Step is optional and depends on the accuracy required. With a 
smaller time step, the creep and shrinkage material properties are updated frequently 
(e.g. using smaller time gaps) hence the accuracy would increase, however the solution 
time will increase accordingly. 
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Tip 
The unit of time is set on the Model Properties dialog by selecting the File > Model 
Properties menu item. 

 
Fig 35 Model Properties 

Age 
The Wizard built model assumes that each member is activated at the same concrete 
Age. The Age property represents the concrete age at the time of activation. (i.e. the 
time gap between pouring the concrete and removal of formwork.) If a different age is 
required for some members, another Age attribute should be defined and assigned 
manually for those members.
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Design Load 
Combinations 

Template for Design Load Combinations 
The template for Design Load Combination is saved in the current working folder 
where the Base Model was built, with the name [Model name]_ComboTemplate.xlsx, 
as shown below. The template can also be downloaded from the Design Load 
Combination dialog.  

Load Factors Worksheet 

 

Fig 36 Template for Design Load Combinations, Load Factors 

 Loadcase Index  The numbers in this row are used to match a Modeller 
loadcase number with a loadcase and its associated details in this template. The 
row should contain a series of numbers with no duplication. 

 Code and Details  Code and Details are used for naming the combination data 
in Modeller.  

 Load Factors Load factors for each loadcase is defined here. 
 Others  All other data are for users reference, and not used for processing. 
 Loadcase to consider can be added. (more columns as necessary can be added.) 
 Load combinations can be added. (more rows as necessary can be added) 
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Loadcases Worksheet 

 

Fig 37 Template for Design Load Combinations, Loadcases 

 Loadcase Name  The loadcase names defined in Modeller. The loadcase 
number may change during the process of updating the model, so the loadcase 
name is used in the definition of the Load Combination. Note that the loadcase 
names used must be the same as the loadcase names defined in Modeller. 

 (LF) Column This column is used to match a Modeller loadcase to a 
corresponding loadcase on the LoadFactors worksheet by entering Loadcase 
Index on the LoadFactors worksheet. For example, the Self Weight loadcase in 
Modeller is used in the ‘Outer Tank Full’ combination defined in LoadFactors 
sheet. By entering 0 (zero), the loadcase is ignored and will not be used in the 
combination. 

 Load Category All other data are for users’ reference only, and not used for 
processing. 

 

Update Base Model 
The template is imported into Modeller by selecting the LNG Tank > Design checks> 
Design Load Combination… 

 
Fig 38 Dialog for Design Load Combination 
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 Template Download Downloads the template to be used for creating load 
combinations to the current working folder. 

 Combination data  Select the load combination template. 
 

On re-loading this template, the Code and Details columns in the LoadFactors 
worksheet will be compared with combination names in Modeller and the load factors 
will be updated. If any new combinations are present, they will be added. However, 
any existing combinations will not be deleted. 

The design load combinations are created as shown below. 

 
Fig 39 Load Combinations Created in Modeller 
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Design Check 
COP Parameters 

Design code parameters can be defined by the selecting the menu item LNG Tank > 
Design Checks > Enable… 

 
Fig 40 Dialog for Design Parameters 
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 Partial Factors for Materials : The partial factors for materials are defined 
based on Table 2.1N on EN1992.  For Persistent & Transient, 1.5, 1.15, 1.15 are 
given to γ c for concrete, γ s for reinforcing steel, γ s for prestressing steel 
respectively.  For Accidental, 1.2, 1.0, 1.0 are given. 

 Yield Stress of Tendon (fyp) : Yield strength of prestressing steel in MPa. 
 Elastic Modulus of Tendon (Ep) : Elastic Modulus of prestressing steel in 

MPa 
 Tensile strength of tendon (fpu) : Tensile strength of prestressing steel in MPa. 

(ACI 318-14 only) 
 Stability coefficient (φ) : Stability coefficient (GB50010-2010 only) 
 Roof concrete grade :  Concrete strength in MPa. 
 Wall concrete grade :  Concrete strength in MPa. 
 Base concrete grade : Concrete strength in MPa. 
 Max Concrete Compressive Strain  : Ultimate strain at concrete failure (ACI 

318-14 only) 
 Long term effect coeff. (αcc) : Long term effect coefficient (EN1991 only) 
 Computation Target for visualization: The design check computations will be 

performed for the targets of 
• Default: The node at Y=0 and X>=0. 
• Selected: The nodes that user selected before opening this dialog 
• Visible: All visible nodes in Modeller. 

 

 Elastic Modulus of rebar (Es) : Elastic Modulus of reinforcing steel in MPa. 
 fse is used and PS is being applied as an external loading:  

• When ‘fse’ is specified in the reinforcement template and the PS being 
applied as external loading, the code-checking that creates the PM chart 
will double count the PS effect. 

• Ticking this option shifts the results to avoid double counting the PS 
effect.  

• When a loadcase (or load combination) does not have PS as external 
loading, this option should be disabled (unticked). 

• It makes no difference if ‘fse’ is not specified in the reinforcement 
template. 
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Shifted force, Pi’      = Pi – fse * Apd 
Shifted moment, Mi’ = Mi – fse * Apd * ecc_ps 

Design Checks for Tank 
Once design code parameters have been defined and the OK button is pressed a Tank 
Design Entity will then be available for selection in relevant result processing dialogs. 
The associated available components are shown below.  

 
Fig 41 Components for Design Checks 

Whenever a results component is chosen, or a loadcase is set active, the design check 
for a selected component will take place. Design checks are carried out on a node-by-
node basis using analysis results and relevant design code formulae. 

UtilPM  (PM Utilization) 
UtilPM can be checked with reference to a PM chart, as illustrated below. A value of 
less than 1 means it satisfies the design code. 
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Fig 42 Definition of UtilPM 

 UtilPM_t is the force and moment utilization in the hoop direction, and 
UtilPM_rz is the utilization in the radial direction for the Roof and Base Slab 
and for the vertical direction for the Wall.  

 Pcapacity_t and Pcapacity_rz is for the computed Pc at the given P1/M1 slope, 
Mcapacity_t, Mcapacity_rz is for the Mc at the given P1/M1 slope. 

 

  

Fig 43 Contour for UtilPM_t, UtilPM_rz 

UtilDC (Decompression Utilization) 
UitilDC is available only for the section contains prestress tendons.  

Please refer to LNG_Tank_System_Manual (Concrete Tank) for more information.  
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ShearResist (Shear Resistances) 
Shear capacity for the tank components is based on concrete shear resistance as per 
COP specifications. 

  

Fig 44 Contour for ShearResist_t, ShearResist_rv 

UtilShear (Shear Utilization) 
Shear utilisation factors are given as the absolute ratio between the shear forces (Sp, St, 
Sz, Sr) and the relevant shear resistances (ShearResist_t and ShearResist_rz). A value 
for UtilShear > 1 denotes failure in shear.  

  

Fig 45 Contour for UtilShear_t, UtilShear_rv 

Design Check Report 
A spreadsheet report that includes a PM chart can be produced by selecting the menu 
item LNG Tank > Design Checks> Design Check Report... 
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Fig 46 Dialog for Design Check Report  

 Target  The design check computations will be performed for the targets of 
• Default: The node at Y=0 and X>=0. 
• Selected : Any nodes that were selected before opening this dialog 
• Visible: All visible nodes in Modeller. 

 Nodal Averaging  
- Unaveraged element results: Unaveraged element results will be output and 
used to compute Utilizations. ‘Peak element only’ option is available only with 
‘Unaveraged element results’ option for Nodal averaging.   
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- Averaged result from active elements: Averaged element results for active 
elements will be output and used to compute Utilizations. ‘Peak element only’ 
option will be disabled. 
- Averaged results from visible elements: Averaged element results only for 
visible elements will be output and used to compute Utilizations. ‘Peak element 
only’ option will be disabled. 

 Avoid pile/Slab, wall/slab intersection: If this checkbox is ticked, the results 
of the base slab nodes located in the pile heads or in the wall and slab 
intersection area where there could be unrealistic high stress concentration will 
not be printed in the report.  

              - Crosswise piles diameter: Diameter of the crosswise piles. 

- Circumferential piles diameter: Diameter of circumferential piles. 

 PM Check Report: ‘PM Check Report’ has been updated to have ‘Tendon(%)’ 
column for ‘Nodal results’ to indicate how much  the % of tendons are 
functioning at that stage/ in that loadcase. Moment shift and force shift % have 
been added to the PM check report as well. Depending on the term of prestress, 
either ‘fse_short’ or ‘fse_long’ can be selectively considered to compute PM 
capacity.  

 

 PM chart type  
 

 

Fig 47 PM chart type dialog 

   PM Check Report: ‘PM Check Report’ has been updated to have ‘Tendon(%)’ 

Following 5 types of PM chart are available. The following options do not affect the 
Utilization results.  
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⋅ Max/Min Thickness (short term PS): PM Chart will be created for Max and 
Min thickness of each part (Base slab, Wall, Roof and Ringbeam) for short 
term Prestress  

⋅ Max/Min Thickness (long term PS): PM Chart will be created for Max and 
Min thickness of each part (Base slab, Wall, Roof and Ringbeam) for long 
term Prestress 

⋅ Short/Long term: PM Chart will be created for Max and Min thickness of 
each part (Base slab, Wall, Roof and Ringbeam) for long term Prestress 

⋅ Tendon/No-Tendon (short term PS): PM Chart will be created including 
tendon and excluding tendon of each part (Base slab, Wall, Roof and 
Ringbeam) for short term Prestress 

⋅ Tendon/No-Tendon (long term PS): PM Chart will be created including 
tendon and excluding tendon of each part (Base slab, Wall, Roof and 
Ringbeam) for long term Prestress 

⋅ Tendon (%) to use in PM Chart: Percentage of tendon (%) to use PM Chart.  
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Fig 48 PM chart  

 Shear Check Report: It has been updated to include ‘Tendon area’ to compute 
shear capacity based on ACI when generate shear check report. 
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If ‘Default’ is selected for Report Target, pre-defined target nodes will be used for each 
of the 15 types of different reinforcement arrangements in the current model, and the 
report will contain 30 worksheets for producing PM charts for two directions 
(hoop/vertical or hoop/radial) for all 15 rebar arrangements. 

 
Fig 49 Design Check Report with PM Chart for Lot 1 

 Section Information at maximum thickness (1) The maximum thickness from 
the selected nodes is printed, for which the PM chart is displayed. 

 Section Information at minimum thickness (2) The minimum thickness from 
the selected nodes is printed, for which the PM chart is displayed. 

 Node  Node number for UtilPM computation 
 Element  Element numbers sharing the node 
 Group  Group name where the node is included in. 
 Thickness  Section thickness at the node location 
 Mi  Bending moment at the node 
 Pi  Axial force at the node 
 Mi’, Pi’  The shifted Mi, Pi when ‘fse is used and PS is being applied as an 

external loading’ option is ticked from the Design Code dialog. 
 UtilPM  PM Utilization 
 PM Chart  Two PM Charts are presented; one for the maximum thickness 

section, the other for minimum thickness section of the selected nodes. The 
value for Pcapacity in Modeller has different sign from the value of Pcapacity 
stated in the PM report 
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